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ABSTRACT

The basis of this project is to design and build a manually controlled exploration robot that would
scan its surroundings and build a map that accurately represents that environment. The main
purpose of the robot is to be able to roam around in a given environment while transmitting back
real time data like video to the ground station. To capture and archive the real time video from the
robot, a camera module is utilized. The camera is attached to a stepper motor which makes it
feasible to capture the scene or object of interest. This real-time visual feedback can then be used
to control the robot. The proposed robot is a compact and self-contained robot with wireless

transmission of data.

The project presented by us can be controlled through RF signals and the robot’s position can be
continuously tracked by GPS in Realtime. The proposed robot has wide applications in areas like

mining, astronomy, military etc.
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INTRODUCTION

The need for exploration robots is paramount in various areas like Mining, Astronomy and Military
etc. As humans are heavy, vulnerable, picky about their environment, and have a low tolerance
for the extreme environment i.e., high energy radiation, extreme heat and cold, these robots reduce

risks to humans by identifying hazardous gases, temperature, pressure, humidity, radiation etc.

Purpose

The goal was to build a small, land-based exploration robot that can be controlled by Raspberry
Pi. We planned to include a variety of features for the robot, including autonomous 2D mapping
of a given location. The main purpose of the robot we are making is to provide visual information

of hard to access places, for example a building under a hostage situation, caves and tunnels.

Objective

Objectives of this project:

To build an exploration robot that serve as physical surrogates for the human bodies.
To explore hard to reach places such as caves and tunnels.

To get visual feedback using cameras.

To produce a 2D map of a given location using LIDAR.

To produce thermal mapping using MLX90614.

To collect data from a suit of sensors such as pressure sensors.

Scope of Project

In order to achieve the objectives of the project, the scopes of work are identified as:
Remotely-controlled mobile robot by computer

Limitation of controlling range is between 50 to 100 meters

Four DC motors are used for mobile robot movement

One wireless camera with 180° degree of panning rotation

Flash LED to light up dark area

A suit of sensors such as VL53L0X, BMP180 and MLX90614



CHAPTER 2
DESIGN

2.2 Raspberry Pi No-IR Camera v2

a
>
—-
-
3

=
o
-
=3

=

Camera VZZl

Made in PRC

8

Figl: Sony IMX219 camera

The camera used is a Raspberry Pi NoIR Camera v2 Camera Module. The camera is a high quality
8 megapixel Sony IMX219 image sensor custom designed add-on board for Raspberry Pi,
featuring a fixed focus lens. It's capable of 3280 x 2464 pixel static images, and also supports
1080p30, 720p60 and 640x480p60/90 video. It attaches to Pi by way of one of the small sockets
on the board upper surface and uses the dedicated CSi interface, designed especially for interfacing
to cameras. The NoIR Camera has No InfraRed (NolIR) filter on the lens which makes it perfect
for doing Infrared photography and taking pictures in low light (twilight) environments.

8 megapixel native resolution sensor-capable of 3280 x 2464 pixel static images.

Supports 1080p30, 720p60 and 640x480p90 video.

Camera is supported in the latest version of Raspbian, Raspberry Pi's preferred operating system.

All software is supported within the latest version of Raspbian Operating System.



2.3 Raspberry Pi

Because we needed functionality to collect the video signal and transmit it, we decided to use the
Raspberry Pi.
The Raspberry Pi is slower than a modern laptop or desktop but is still a complete Linux computer

and can provide all the expected abilities that implies, at a low-power consumption level.

Raspberry Pi 3

6P10 CONNECTOR -

g Raspberry Pi 3 Model B M

Fig2: Raspberry pi 3

2.4 Motor Driver

The motor module we used is an H-bridge chip i.e; L298D motor driver to connect to the motors
of the robot. Along with the chip were several diodes and capacitors that were used as the data
sheet for the H-bridge dictated. The entire design controls forward and backward motion for both
wheels. The wires connected to the motors are connected to general purpose input-output (GPIO)

pins on the microcontroller.
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Fig3: H bridge driver

2.5 Time of Flight sensor:

VL53L0X a new generation Time-of-Flight (ToF) laser-ranging module is used. It provides
accurate distance measurement whatever the target reflectances unlike conventional technologies.
It can measure absolute distances up to 2m hence opening the door to various new applications
and enhancing the capability of our robot.

The VL53L0X integrates a leading-edge SPAD array (Single Photon Avalanche Diodes) and
embeds ST’s second generation Flight Sense patented technology.

The VL53L0X’s 940nm VCSEL emitter (Vertical Cavity Surface-Emitting Laser), is totally
invisible to the human eye. Coupled with internal physical infrared filters, it enables longer
ranging distance, higher immunity to ambient light and better robustness to cover-glass optical
cross-talk which is one of the most important features required by an exploration robot.

VL53L0X module

VL53L0X silicon

Detection array

GND Single Photon AVDD
Avalanche Diode (SPAD)

SDA XSHUT

SCL GPIO1

AvssveseL —ji] — ~voovcseL

Fig4: VL53L0X architecture



2.6 Contactless Temperature Sensor: MLX90614

The MLX90614 is a fully calibrated 16x4 pixels IR array in an industry standard 4-lead TO-39
package. It contains 2 chips in one package: the MLX90670 (IR array with signal conditioning
electronics) and the 24AA02 (256x8 EEPROM) chip. The MLX90614 contains 64 IR pixels with
dedicated low noise chopper stabilized amplifier and fast ADC integrated. A PTAT (Proportional
to Absolute Temperature) sensor is integrated to measure the ambient temperature of the chip. The
outputs of both IR and PTAT sensors are stored in internal RAM and are accessible through 12C.
Depending on the application, the external microcontroller can read the different RAM data and,
based on the calibration data stored in the EEPROM memory, compensate for difference between
sensors to build up a thermal image, or calculate the temperature at each spot of the imaged scene.
These constants are accessible by the user microcontroller through the 12C bus and have to be used
for external post processing of the thermal data. This post processing includes:

- Ta calculation

- Pixel offset cancelling

- Pixel to pixel sensitivity difference compensation

- Object emissivity compensation

- Object temperature calculation

The result is an image with NETD better than 0.1K RMS at 1Hz refresh rate.

The refresh rate of the array is programmable by means of register settings or directly via 12C
command. Changes of the refresh rate have a direct impact on the integration time and noise
bandwidth (faster refresh rate means higher noise level). The frame rate is programmable in the
range 0.5Hz...512Hz and can be changed to achieve the desired trade-off between speed and
accuracy.

The MLX90614 requires a single 2.6V...3.2V although the device is calibrated and performs best
at VDD=2.6V.

The MLX90614 is factory calibrated in following temperature ranges:

- -40°C...85°C for the ambient temperature sensor

- -50°C...300°C for the object temperature.



Fig5: MLX90614
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2.7 Arduino
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Fig7: Atmega328Pu Pin diagram
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Fig8: Atmega328Pu Architecture

The reason for choosing Atmel PicoPower ATmega328/P is because it’s a low-power CMOS 8-
bit microcontroller based on the AVR enhanced RISC architecture which executes powerful
instructions in a single clock cycle. It ATmega328/P achieves throughputs close to 1IMIPS per
MHz. This empowers system designer to optimize the device for power consumption versus

processing speed.

Since power consumption is a critical part in electronics, it is important to consider and choose
the most appropriate and power efficient microcontroller. One of the biggest advantages of
picoPower over the other AVRs is the power save mode which uses only 0.6uA with the oscillator
running. Finally, in full run mode, it can do as low as 220uA per MIP in full active mode. These
devices run from 1.8-5.5V. The 1.8V device is a true 1.8V device. That means that everything
works at 1.8V thus enabling us to write to Flash, SRAM and EEPROM.

The Atmel AVR® core combines a rich instruction set with 32 general purpose working registers.
All the 32 registers are directly connected to the Arithmetic Logic Unit (ALU), allowing two
independent registers to be accessed in a single instruction executed in one clock cycle. The



resulting architecture is more code efficient while achieving throughputs up to ten times faster
than conventional CISC microcontrollers. The ATmega328/P provides the following features:
32Kbytes of In-System Programmable Flash with Read-While-Write capabilities, 1Kbytes
EEPROM, 2Kbytes SRAM, 23 general purpose I/O lines, 32 general purpose working registers,
Real Time Counter (RTC), three flexible Timer/Counters with compare modes and PWM, 1 serial
programmable USARTSs , 1 byte-oriented 2-wire Serial Interface (12C), a 6-channel 10-bit ADC
(8 channels in TQFP and QFN/MLF packages) , a programmable Watchdog Timer with internal
Oscillator, an SPI serial port, and six software selectable power saving modes. The Idle mode
stops the CPU while allowing the SRAM, Timer/Counters, SPI port, and interrupt system to
continue functioning. The Power-down mode saves the register contents but freezes the Oscillator,
disabling all other chip functions until the next interrupt or hardware reset. In Power-save mode,
the asynchronous timer continues to run, allowing the user to maintain a timer base while the rest
of the device is sleeping. The ADC Noise Reduction mode stops the CPU and all /0O modules
except asynchronous timer and ADC to minimize switching noise during ADC conversions. In
Standby mode, the crystal/resonator oscillator is running while the rest of the device is sleeping.
This allows very fast start-up combined with low power consumption. In Extended Standby mode,

both the main oscillator and the asynchronous timer continue to run.

SPI- Serial Peripheral Interface

The Serial Peripheral Interface (SPI) allows high-speed synchronous data transfer between the

device and peripheral units, or between several AVR devices.

To enable the SPI module, Power Reduction Serial Peripheral Interface bit in the Power
Reduction

Register (PRR.PRSPI0) must be written to '0".

Features

* Full-duplex, Three-wire Synchronous Data Transfer
* Master or Slave Operation

* LSB First or MSB First Data Transfer

« Seven Programmable Bit Rates

* End of Transmission Interrupt Flag

» Write Collision Flag Protection

» Wake-up from Idle Mode

* Double Speed (CK/2) Master SPI Mode



USART - Universal Synchronous Asynchronous Receiver Transceiver

Overview

The Universal Synchronous and Asynchronous serial Receiver and Transmitter (USART) is a
highly flexible serial communication device.

The USART can also be used in Master SPI mode. The Power Reduction USART bit in the Power
Reduction Register must be written to ‘0" in order to enable USARTN. USART 0 is in PRR.

Features

« Full Duplex Operation (Independent Serial Receive and Transmit Registers)
+ Asynchronous or Synchronous Operation

* Master or Slave Clocked Synchronous Operation

« High Resolution Baud Rate Generator

* Supports Serial Frames with 5, 6, 7, 8, or 9 data bits and 1 or 2 stop bits

+ Odd or Even Parity Generation and Parity Check Supported by Hardware

» Data OverRun Detection

* Framing Error Detection

* Noise Filtering Includes False Start Bit Detection and Digital Low Pass Filter
* Three Separate Interrupts on TX Complete, TX Data Register Empty and RX Complete
* Multi-processor Communication Mode

* Double Speed Asynchronous Communication Mode



2.8 119341

Fig9: 1L19341 display

IL19341 is a 262,144-color single-chip SOC driver for a-TFT liquid crystal display with resolution
of 240RGBx320 dots, comprising a 720-channel source driver, a 320-channel gate driver, 172,800
bytes GRAM for graphic display data of 240x320 RGB dots, and power supply circuit. 1L19341
supports parallel 8-/9-/16-/18-bit data bus MCU interface, 6-/16-/18-bit data bus RGB interface
and 3-/4-line serial peripheral interface (SPI). The moving picture area can be specified in internal
GRAM by window address function. The specified window area can be updated selectively, so
that moving picture can be displayed simultaneously independent of still picture area 1L19341 can
operate with 1.65V ~ 3.3V 1/O interface voltage and an incorporated voltage follower circuit to
generate voltage levels for driving an LCD. 1L19341 supports full colour, 8-color display mode
and sleep mode for precise power control by software and these features make the 1L19341 an
ideal LCD driver for medium or small size portable products such as digital cellular phones, smart
phone, MP3 and PMP where long battery life is a major concern.



Serial Interface

IL19341 supplies 3-lines/ 9-bit and 4-line/8-bit bi-directional serial interfaces for communication
between host and 1L19341. The 3-line serial mode consists of the chip enable input (CSX), the
serial clock input (SCL) and serial data Input/output (SDA or SDI/SDO). The 4-line serial mode
consists of the Data/Command selection input (D/CX), chip enable input (CSX), the serial clock
input (SCL) and serial data Input/output (SDA or SDI/SDO) for data transmission

2.9 NEO-5 u-blox GPS Module:

The NEO-5 series by u-blox sets a new standard for GPS receiver modules. Powered by the high
performance 50-channel u-blox 5 technology, these modules provide excellent performance at an
economical price. A 32-channel acquisition engine with over 1 million effective correlators is
capable of massive parallel searches across the time/frequency space. This enables a Time to First
Fix (TTFF) of less than 1 second while long correlation/dwell times make possible the best-in-
class acquisition and tracking sensitivity. An available functionality is KickStart, a new feature
enabling accelerated acquisition of weak signals. Once acquired, satellites are passed on to a
power-optimized dedicated tracking engine. This arrangement allows the GPS engine to
simultaneously track up to 16 satellites while searching for new ones. U-blox 5’s advanced
jamming suppression mechanism and innovative RF architecture provides a high level of
immunity to jamming, ensuring maximum GPS performance. The miniature 12.2 x 16 mm form
factor of the successful NEO-4S module is maintained, permitting easy migration. An 12C
compatible DDC interface is provided to connect an optional external serial E2PROM to store
power-up configuration settings. The 1.8V NEO-5D and NEO-5G modules provide the
exceptional performance of u-blox 5 positioning while enabling power savings in the order of
40%.

NEO-5 modules come equipped with a serial port, which can handle NMEA and UBX proprietary
data formats, as well as a high speed USB port. It also offers power optimized architecture with
built-in autonomous power saving functions that minimize power consumption at any given time.

It can operated in two different power modes. Maximum Performance and Eco mode.



Fig10: GPS module

2.10 BMP180

The BMP180 is the function compatible successor of the BMPO085, a new generation of high
precision digital pressure sensors for consumer applications. The ultra-low power, low voltage
electronics of the BMP180 is optimized for use in mobile phones, PDAs, GPS navigation devices
and outdoor equipment. With a low altitude noise of merely 0.25m at fast conversion time, the
BMP180 offers superior performance. The 12C interface allows for easy system integration with
a microcontroller. The BMP180 is based on piezo-resistive technology for EMC robustness, high
accuracy and linearity as well as long term stability. Based on the experience of over 400 million
pressure sensors in the field, the BMP180 continues a new generation of micro-machined pressure

Sensors.

The BMP180 is designed to be connected directly to a microcontroller of a mobile device via the
12C bus. The pressure and temperature data has to be compensated by the calibration data of the
E2PROM of the BMP180. The BMP180 consists of a piezo-resistive sensor, an analog to digital
converter and a control unit with E2ZPROM and a serial 12C interface. The BMP180 delivers the

uncompensated value of pressure and temperature. The E2PROM has stored 176 bit of individual



calibration data. This is used to compensate offset, temperature dependence and other parameters
of the sensor.

UP = pressure data (16 to 19 bit)

UT = temperature data (16 bit)

The microcontroller sends a start sequence to start a pressure or temperature measurement. After
converting time, the result value (UP or UT, respectively) can be read via the 12C interface. For
calculating temperature in °C and pressure in hPa, the calibration data has to be used. These
constants can be read out from the BMP180 E2PROM via the I12C interface at software

initialization.

The 12C bus is used to control the sensor, to read calibration data from the E2PROM and to read
the measurement data when A/D conversion is finished. SDA (serial data) and SCL (serial clock)

have open-drain outputs.

Figll: BMP180



2.11 FlySky FS-i16 2.4G 6CH AFHDS RC Transmitter with FS-iA6
Receiver

Works in the frequency range of 2.405 to 2.475GHz. This band has been divided into 142
independent channels, each radio system uses 16 different channels and 160 different types of

hopping algorithm.

This radio system uses a high gain and high quality multi directional antenna, it covers the whole
frequency band. Associated with a high sensitivity receiver, this radio system guarantees a

jammingfree  long-range  radio transmission.

Each transmitter has a unique ID, when binding with a receiver, the receiver saves that unique ID
and can accepts only data from the unique transmitter. This avoids picking another transmitter

signal and dramatically increase interference immunity and safety.

This radio system uses low power electronic components and sensitive receiver chip. The RF

modulation uses intermittent signal thus reducing even more power consumption.

AFHDS2A system has the automatic identification function, which can switch automatically
current mode between single-way communication mode and two-way communication mode

according to the customer needs.

AFHDS2A has built-in multiple channel coding and error-correction, which improve the stability

of the communication, reduce the error ratio and extend the reliable transmission distance.



Fig12: Flysky Transmitter and Receiver

2.12 ATMEGA 2560

The ATmega640/1280/1281/2560/2561 is a low-power CMQOS 8-bit microcontroller based on the
AVR enhanced RISC architecture. By executing powerful instructions in a single clock cycle, the
ATmega640/1280/1281/2560/2561 achieves throughputs approaching 1 MIPS per MHz allowing
the system designer to optimize power consumption versus processing speed.

The ATmega640/1280/1281/2560/2561 provides the following features: 64K/128K/256K bytes
of In-System Programmable Flash with Read-While-Write capabilities, 4Kbytes EEPROM,
8Kbytes SRAM, 54/86 general purpose I/O lines, 32 general purpose working registers, Real Time
Counter (RTC), six flexible Timer/Counters with compare modes and PWM, four USARTS, a byte
oriented 2-wire Serial Interface, a 16-channel, 10-bit ADC with optional differential input stage
with programmable gain, programmable Watchdog Timer with Internal Oscillator, an SPI serial
port, IEEE® std. 1149.1 compliant JTAG test interface, also used for accessing the On-chip Debug
system and programming and six software selectable power saving modes. The Idle mode stops
the CPU while allowing the SRAM, Timer/Counters, SPI port, and interrupt system to continue
functioning. The Power-down mode saves the register contents but freezes the Oscillator,
disabling all other chip functions until the next interrupt or Hardware Reset. In Power-save mode,

the asynchronous timer continues to run, allowing the user to maintain a timer base while the rest



of the device is sleeping. The ADC Noise Reduction mode stops the CPU and all 1/0 modules
except Asynchronous Timer and ADC, to minimize switching noise during ADC conversions. In
Standby mode, the Crystal/Resonator Oscillator is running while the rest of the device is sleeping.
This allows very fast start-up combined with low power consumption. In Extended Standby mode,

both the main Oscillator and the Asynchronous Timer continue to run.

Atmel offers the QTouch® library for embedding capacitive touch buttons, sliders and wheels
functionality into AVR microcontrollers. The patented charge-transfer signal acquisition offers
robust sensing and includes fully denounced reporting of touch keys and includes Adjacent Key
Suppression® (AKS®) technology for unambiguous detection of key events. The easy-to-use

QTouch Suite toolchain allows you to explore, develop and debug your own touch applications.

The device is manufactured using the Atmel high-density nonvolatile memory technology. The
On-chip ISP Flash allows the program memory to be reprogrammed in-system through an SPI
serial interface, by a conventional non-volatile memory programmer, or by an On-chip Boot
program running on the AVR core. The boot program can use any interface to download the
application program in the application Flash memory. Software in the Boot Flash section will
continue to run while the Application Flash section is updated, providing true Read-While-Write
operation. By combining an 8-bit RISC CPU with In-System Self-Programmable Flash on a
monolithic chip, the Atmel ATmega640/1280/1281/2560/2561 is a powerful microcontroller that

provides a highly flexible and cost-effective solution to many embedded control applications.

The Arduino Mega2560 has a number of facilities for communicating with a computer, another
Arduino, or other microcontrollers. The ATmega2560 provides four hardware UARTS for TTL
(5V) serial communication. An ATmega8U2 on the board channels one of these over USB and
provides a virtual com port to software on the computer (Windows machines will need a .inf file,
but OSX and Linux machines will recognize the board as a COM port automatically. The Arduino
software includes a serial monitor which allows simple textual data to be sent to and from the
board. The RX and TX LEDs on the board will flash when data is being transmitted via the
ATmega8U2 chip and USB connection to the computer (but not for serial communication on pins
Oand 1).



ATMEGA16u2 WEEE]
Responsavel pela o
Comunicacdo USB Comunicagbes !

Saidas PWM Serial

Conector
USB Tipo B Entradas/Saidas
Digitais de

Fusivel para usG:geral
Protecédo da USB

Regulador 5V
FONTE EXTERNA

7al2v
Pinos de alimentagéo Entradas analégicas Botdo de RESET
Regulador 3,3 V
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CHAPTER 3
THERMAL MAPPING

Thermal Mapping is a process by which the spatial variation of minimum night-time road surface
temperature is measured, using a high resolution infrared thermometer. Vaisala Thermal Mapping
is the only proven and established technique to determine surface temperature relationships likely
to occur across an entire road or runway network. It is a technique, which has been utilized
worldwide, to enhance the information available to both highway authorities and supporting
forecast providers. Thermal Mapping is an integral part of an effective Ice Prediction system as it
provides a mechanism for extending point specific sensor site information between individual

weather stations and across a road network.

Thermal Mapping identifies patterns of temperature variation, by undertaking accurate
measurements of winter night time surface temperatures across pre-defined sections of a highway
or runway network under a range of different weather conditions. This pattern and distribution of
warm and cold sections is determined by local environmental factors and prevailing weather
conditions. The occurrence of frost or ice is determined by the balance of energy a surface receives
and loses in conjunction with the amount of available moisture. This is influenced by the complex

relationship between a number of factors including:

Prevailing weather conditions.

Sky view factor (exposure). This will be dictated by features such as vegetation, buildings and
tunnels etc. A low sky view indicates features overhanging or close to the road or runway. Such
features will inhibit night-time cooling and may help the surface to retain some of its heat. A high
sky view will relate to an open environment that will exhibit cold night-time road temperatures,
as there is nothing to prevent the surface cooling.

Altitude (temperatures decrease with height).

Proximity to the coast and major water bodies.

Urban heat island effect.

Cuttings, embankments, elevated sections. These are localized features that will affect the energy
flux of the road/runway at that point.

Road/runway construction (surface material e.g. concrete/asphalt/open asphalt, and depth of
construction).

Traffic volume and flow.



The combination of these factors generates a unique temperature fingerprint for each road/runway.
Thermal Mapping establishes the relationship between these variables and how they interact under

different weather scenarios.



CHAPTER 4
DEPTH MAPPING

In 3D computer graphics a depth map is an image or image channel that contains information
relating to the distance of the surfaces of scene objects from a viewpoint. The term is related to
and may be analogous to depth buffer, Z-buffer, Z-buffering and Z-depth.[1] The "Z" in these
latter terms relates to a convention that the central axis of view of a camera is in the direction of

the camera's Z axis, and not to the absolute Z axis of a scene.

Uses

Depth maps have a number of uses, including:

Simulating the effect of uniformly dense semi-transparent media within a scene - such as fog,
smoke or large volumes of water.

Simulating shallow depths of field - where some parts of a scene appear to be out of focus. Depth
maps can be used to selectively blur an image to varying degrees. A shallow depth of field can be
a characteristic of macro photography and so the technique may form a part of the process of
miniature faking.

Z-buffering and z-culling, techniques which can be used to make the rendering of 3D scenes more
efficient. They can be used to identify objects hidden from view and which may therefore be
ignored for some rendering purposes. This is particularly important in real time applications such
as computer games, where a fast succession of completed renders must be available in time to be
displayed at a regular and fixed rate.

Shadow mapping - part of one process used to create shadows cast by illumination in 3D computer
graphics. In this use, the depth maps are calculated from the perspective of the lights, not the

viewer.

Limitations

Single channel depth maps record the first surface seen, and so cannot display information about
those surfaces seen or refracted through transparent objects, or reflected in mirrors. This can limit
their use in accurately simulating depth of field or fog effects.

Single channel depth maps cannot convey multiple distances where they occur within the view of

a single pixel. This may occur where more than one object occupies the location of that pixel. This



could be the case - for example - with models featuring hair, fur or grass. More generally, edges
of objects may be ambiguously described where they partially cover a pixel.

Depending on the intended use of a depth map, it may be useful or necessary to encode the map
at higher bit depths. For example, an 8 bit depth map can only represent a range of up to 256
different distances.

Depending on how they are generated, depth maps may represent the perpendicular distance
between an object and the plane of the scene camera. For example, a scene camera pointing
directly at - and perpendicular to - a flat surface may record a uniform distance for the whole
surface. In this case, geometrically, the actual distances from the camera to the areas of the plane
surface seen in the corners of the image are greater than the distances to the central area. For many

applications, however, this discrepancy is not a significant issue.



CHAPTER 5
LINEAR MAPPING

In mathematics, a linear map (also called a linear mapping, linear transformation or, in some

contexts, linear function) is a mapping V. — W between two modules (including vector spaces)

that preserves (in the sense defined below) the operations of addition and scalar multiplication.

An important special case is when V = W, in which case the map is called a linear operator, or an
endomorphism of V. Sometimes the term linear function has the same meaning as linear map,

while in analytic geometry it does not.

A linear map always maps linear subspaces onto linear subspaces (possibly of a lower dimension)
for instance it maps a plane through the origin to a plane, straight line or point. Linear maps can
often be represented as matrices, and simple examples include rotation and reflection linear

transformations.

A specific application of linear maps is for geometric transformations, such as those performed in
computer graphics, where the translation, rotation and scaling of 2D or 3D objects is performed
by the use of a transformation matrix. Linear mappings also are used as a mechanism for
describing change: for example in calculus correspond to derivatives; or in relativity, used as a

device to keep track of the local transformations of reference frames.

Another application of these transformations is in compiler optimizations of nested-loop code, and

in parallelizing compiler techniques.



CHAPTER 6
UV4L SERVER ON RASPBERRY PI

The uv4l-server module is a plug-in specific for UVAL which enables a per-camera Streaming

Server that can be simultaneously accessed by any browser over HTTP or HTTPS protocols.

Among the other things, it offers a Web interface from which it’s possible to see the video stream
in various ways and a Control Page allowing to fully control the camera settings while streaming
with any Video4Linux application. Other than secure HTTPS protocol, basic authentication for
both the normal and admin users is also supported.

UV4L was originally conceived as a modular collection of Video4Linux2-compliant, cross-
platform, user space drivers for real or virtual video input and output devices (with absolutely no
external difference from kernel drivers), and other pluggable back-ends or front-ends.

It has evolved over the years and now includes a full-featured Streaming Server component with
a customizable web Ul providing a set of standard, modern and unique solutions for encrypted
live bidirectional data, audio and video streaming, mirroring or conferencing over the web and for
the l1oT. Since recent releases UV4L has also been providing a RESTful API for the developers

who want to implement their custom applications.



CHAPTER 7
RADIO LINK GFSK

Modulation plays a very important role in communication. During the inception of
communication there are some analog modulation technics are used, as time roles digital
modulation technics are emerged.

We going to discuss about one such modulation technic known as Gaussian frequency shift keying
A GFSK modulator is similar to a FSK modulator, except that before the baseband waveform goes
into the FSK modulator, it is passed through a Gaussian filter to make the transitions smoother so

to limit its spectral width. Gaussian filtering is a standard way for reducing spectral width

Let’s understand GFSK technic with the help of GNU Radio.

GNU Radio is an open source software tool. Blocks in GNU Radio companion is to generate and
process a waveform and GNU Radio companion comes with some modulation blocks which helps
to demonstrate modulation technics.

Gaussian frequency shift keying (GFSK) is a modulation method used in many standards such as
Cordless Telecommunications and Bluetooth.

GFSK accounts to translating symbols into a signals that transmitting side can send into a
transmission medium and from which the receiving side can recover the original symbols.

To carry out GFSK technic in GNU Radio companion we need to use GFSK block and for

generation and visualization of waveform we use source and scope sink blocks.



CHAPTER 8
PLOTTING RESULTS

We obtain the various plotting results in this section. The three modes which are plotted by the
exploration rover are: Thermal plotting, Depth plotting, and Altitude plotting. The modes can be
switched using the toggle button. The different plotting results and the design for plotting them is

provided by images below.
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 +0 switch mode

Figl5: Depth Plotting
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Fig16: Thermal Plotting
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CHAPTER 9
THE ARDUINO INTEGRATED DEVELOPMENT
ENVIRONMENT

The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text editor
for writing code, a message area, a text console, a toolbar with buttons for common functions and a
series of menus. It connects to the Arduino and Genuino hardware to upload programs and communicate

with them.

9.1 Writing sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are written in the
text editor and are saved with the file extension .ino. The editor has features for cutting/pasting and for
searching/replacing text. The message area gives feedback while saving and exporting and also displays
errors. The console displays text output by the Arduino Software (IDE), including complete error
messages and other information. The bottom right-hand corner of the window displays the configured
board and serial port. The toolbar buttons allow you to verify and upload programs, create, open, and

save sketches, and open the serial monitor.

9.2 Uploading

Before uploading your sketch, you need to select the correct items from the Tools > Board and Tools >
Port menus. When you upload a sketch, you're using the Arduino bootloader, a small program that has
been loaded on to the microcontroller on your board. It allows you to upload code without using any
additional hardware. The bootloader is active for a few seconds when the board resets; then it starts
whichever sketch was most recently uploaded to the microcontroller. The bootloader will blink the on-
board (pin 13) LED when it starts (i.e. when the board resets).

9.3 Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or manipulating
data. To use a library in a sketch, select it from the Sketch > Import Library menu. This will insert one
or more #include statements at the top of the sketch and compile the library with your sketch. Because
libraries are uploaded to the board with your sketch, they increase the amount of space it takes up. If a

sketch no longer needs a library, simply delete its #include statements from the top of the code.



9.4 Boards

The board selection has two effects: it sets the parameters (e.g. CPU speed and baud rate) used when compiling
and uploading sketches; and sets and the file and fuse settings used by the burn bootloader command. Some
of the board definitions differ only in the latter, so even if you've been uploading successfully with a particular
selection you'll want to check it before burning the bootloader. You can find a comparison table between the

various boards.

Arduino Software (IDE) includes the built in support for the boards in the following list, all based on the AVR
Core. It includes the standard installation allows to add support for the growing number of new boards based

on different cores like Arduino Due, Arduino Zero, Edison, and Galileo and so on.



CHAPTER 10
CONCLUSION

10.1 Accomplishments

The completed project is a small land-based rover that can be controlled using a FlySky fs-i6. The
controller allows the user to send commands to the robot for moving forward and backwards,
turning left and right, and stopping. In addition, we also have thermal, depth mapping and visual

feedback to get the data about the surroundings.

10.2 Ethical Considerations

The original design has some ethical considerations pertaining to the use of the video camera. It
is possible for the camera to be used to record someone or someplace without proper permissions
which could have potentially been used for inflicting damage to mankind. But a small land-based

remote control robot cannot be used to significantly harm others.

10.3 Future Work

The most immediate future work that could be done for the project is debugging and finishing the
implementation of a two-way data connection. After a reliable connection is established, further
debugging would have to be done to ensure that correct data is coming from the different sensors.
Once that is completed, the mapping algorithm could be properly tested and debugged using the
completed robot.

There are many potential additional features for the project. They include:

e adding the video camera to the robot and streaming video data to be displayed on the Android
app.

e fixing the low battery circuit and implementing a low battery warning to be displayed to the
user.

e implementing basic motion detection when the robot is stationary using the video data. This
could be done with image processing between frames of the video feed. If a significant difference

between the frames is detected, the robot could output a notification to the user.



